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Introduction

Introduction
Congratulations on your choice of the state of the art
®
Quicktionary 2 Premium from WizCom Technologies.
WizCom makes personal, portable scanning Pens that
assist with reading, understanding and utilizing text.
®
Use the Quicktionary 2 Premium to scan full lines of text,
receive word-by-word translations, and hear scanned
words pronounced aloud. Use the CD provided with the
Pen to install one or more of a wide range of dictionaries.
®
The Quicktionary 2 Premium can also scan and store
printed material anytime and anywhere. Use the Pen to
store over 500 pages of printed text, in a wide range of
fonts and sizes, for easy transfer to a PC, PDA or
Smartphone. Text can also be scanned directly into any
Windows-based application for ultimate productivity!
This manual is divided into four sections:
1. Getting Started - This section provides basic
information on Pen functions and how to scan, on
®
using the Quicktionary 2 Premium CD, installing the
WizCom Desktop and establishing Pen-PC
Communications.
®
2. The Quicktionary 2 Premium - This section
demonstrates how to work with the Pen, including
explanations of all the Pen menu options,
applications and different ways of scanning, inserting
and editing text in files.
3. The WizCom Desktop - This section demonstrates
the use of the PC application used for transferring
and synchronizing data between the Pen and PC.
4. Additional
Information
View
additional
information such as Pen maintenance information.

Contact and Support Information
Contact us at 888 777 0552 (Toll free in USA) or +1 978
727 0026 or email usa.support@wizcomtech.com. Visit
http://www.wizcomtech.com to view the FAQ section for
®
the Quicktionary 2 Premium and to register your product.
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Getting Started
Familiarizing Yourself with the Pen
The Pen Parts
Your Pen contains the following parts:

Front and Rear Views

Top View

Important: Before using the headphones, please adjust
the volume using the Set Volume option in the Scan and
Translate menu (available when the dictionary is set to
EnglishChinese Simp.
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Setting Up Your Pen
To get started:
1. Remove your Pen from its protective case.
2. Remove the battery compartment cover from the
back of the Pen.
3. Insert 2 AAA batteries into the Pen with the positive
and negative terminals corresponding to the markings
on the sides of the battery compartment.
4. Close the battery compartment.
5. Remove the protective cover from the Pen tip.
6. Press
to turn the Pen on.
7. The Pen is ready to scan!
Note: If you are left-handed, see Set Right-Left-Handed
on page 29 to change your Pen to left-handed scanning.

Basic Pen Commands
The Pen Keys and their Functions
The keypad contains seven keys for operating your Pen.
Use the keys as follows:
 Power key
: Turn the Pen on and off.
 ENT key
: Access submenus or screens, confirm
a selection or perform an operation.
 ESC key
: Navigate backwards, close a screen,
or cancel an operation.
 Direction keys
: Scroll through menus and
screens.

Navigating Menus and Lists
To select an item from a menu or a list:
1. Scroll through the menu, using
or
until the item
you want is highlighted.
2. Press ENT.
To select a command key on the display:
1. Use the direction keys to highlight the command key.
2. Press ENT.
To return to a previous menu level from a sub-menu,
option or list, press ESC.
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Scanning Guidelines
Scanning Mode
The Pen is in scanning mode when the red light at the tip
of the Pen is blinking. Scanning mode is disabled when
accessing menus.

Scanning Direction
Text can be scanned from right to left or from left to right.
Both will produce the same results.

Scanning Restrictions
The Pen scans and recognizes printed text in a wide
range of languages, font types and point sizes (6-22
points, up to 8mm) and in a variety of colors on
contrasting backgrounds (except red on white, white on
red, blue on black and black on blue).
It does not recognize handwriting, cursive fonts,
mathematical symbols or other profession-specific signs.

Tips for Good Scanning
To ensure optimum scanning results:
 Hold the Pen at the correct scanning angle.
 Place the scanning material on a flat surface.
 Ensure scanning material is good quality and pages
are not creased. Poorly photocopied materials may
provide bad results.
 Do not scan too fast.

Correct scanning angle of 90°

Poor Character Recognition
Poor character recognition may occur for the following
reasons:
 Low quality scanning material.
 The scanning settings are not set correctly (e.g.
Inverse).
 Holding the Pen at the wrong scanning angle.
 Scanning too fast.
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Learning to Scan (using the Trainer)

This tutorial uses the Scan and Store application and the
plastic scanning Trainer provided with your Pen.
1. Slide the Trainer onto the tip of the Pen (instead of
the cap) and press into place.

2.

3.
4.
5.
6.

Turn the Pen on. The Pen Main Menu appears. If
the Pen Main Menu does not appear, press ESC
until it is visible on screen.
Scroll to the Scan and Store application using the
direction keys and press ENT.
Scroll down to New File and press ENT.
Scroll down to OK and save the default file name. A
blank screen appears with a blinking cursor.
Position the Pen at a 90° angle and center the
following text between the feet of the trainer. This
angle should be maintained even when scanning
without the trainer.
Use the following practice sentence:

This sentence will help me practice scanning.

7.

8.

Glide the Pen from right to left in a straight line over
the text. Start scanning 1cm from the end of the text
and finish 1cm after the beginning of the text.
The scanned text will appear on the screen. If the
text does not appear correctly on the screen, press
ENT to erase it and scan again.
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The Quicktionary®2 Premium CD
®

The Quicktionary 2 Premium CD should run automatically
when you insert it into the drive on your PC. If the setup
does not begin automatically:
1. Click the Windows Start button and select Run.
2. Type x:\setup.exe (where x is your CD-ROM drive),
then click OK.
®

Use the Quicktionary 2 Premium CD to:
 Set Up Product on PC: Install the USB driver and
WizCom Desktop necessary for transferring data
between your Pen and PC.
 Install additional dictionaries. The USB driver must
be installed (from Set Up Product on PC) before
you can install any dictionaries.
 Restore your Pen to its original configuration should
you accidentally delete components.

Installing the WizCom Desktop
While the Pen can be used as a stand-alone device,
®
installing the WizCom Desktop from the Quicktionary 2
Premium CD allows you to transfer Scan and Store files
between your Pen and PC. To install the Desktop you will
®
need your Pen, the Quicktionary 2 Premium CD and USB
cable provided with the Pen.
Important: Do not connect the USB cable to your
computer until you have completed the USB driver
installation.
To install the Desktop:
1. Insert the CD into the drive on your computer. If the
setup does not begin automatically:
 Click the Windows Start button and select Run.
 Type x:\setup.exe (where x is your CD-ROM drive),
then click OK.
2. The CD browser window will appear.
3. From the Main Menu click Install Product on PC.
4. Follow the instructions on the CD to install first the
USB driver and then the WizCom Desktop.
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Note: Please restart your computer if requested to during
the installation procedure.

Establishing Pen-PC Communications
Do the following to check that your Pen and PC are
configured correctly for Pen-PC Communications:

On the Pen:
To set the Pen communications settings:
1. Turn the Pen on, scroll down to Options in the Pen
Main Menu and press ENT.
2. Scroll down to Advanced Options and press ENT.
3. Scroll down to Set Serial/IR Comm. and press
ENT.
4. Select Cable and press ENT.
5. Scroll down to Set Baud Rate and press ENT.
6. The baud rate should be set to 115,200. Scroll down
until you see 115200 on screen and press ENT.
7. Press ESC twice to return to the Pen Main Menu.

On the Desktop:
To view the Desktop application communications settings
select Communications Settings from the Pen
Communications menu on the Menu Bar of the
Desktop application.
The Communications Settings dialog box appears:
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The correct settings (when using the USB cable) should
be as follows:
1. The Port should correspond to the COM port being
used by the Pen. To find out whether the port is
correct do the following:
a. On your computer go to Start/Settings/Control
Panel and select System.
b. Click on the Hardware tab and then click on the
Device Manager.
c. Scroll down to Ports (COM & LPT) and open
the drop-down list of ports.
d. Find the "Prolific USB-to-Serial Comm Port" and
note the corresponding COM port number.

Viewing the Ports list in the Device Manager

e. Go back to the Communications Settings
dialog box and modify the Port option
accordingly.
2. The baud rate should be set to 115,200.
3. If you are changing the connection device from Cable
to Infra-Red, click on the Infra-Red checkbox and
then select the correct driver from the drop-down list.
Using Infra-Red for communications is not
recommended.
4. Click OK.
Note: If the "Prolific USB-to-Serial Comm Port" is not
listed under Ports (COM & LPT) it means that the USB
driver has not been installed correctly. Go back to the CD
and rerun the driver installation. If at any stage you are
requested to restart your computer, please do so.
Once this is complete, run the Communications Wizard
to establish communications between your Pen and the
PC. The Communications Wizard can be accessed
from the Help menu on the Menu Bar of the WizCom
Desktop.
10
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Main Pen Functions

You can access all the main Pen functions from the Pen
Main Menu which can be seen when turning your Pen on
for the first time. Use the direction keys to scroll through
the menu options, and ENT to enter an application or
access a function or menu. Press ESC to return to the
Pen Main Menu from within any of the options.
The Pen Main Menu contains the following options:

Scan and Store
The Scan and Store application enables you to scan
printed text into your Pen. This text can later be
transferred to your computer or beamed to an infra-red
device. See page 12.
Scan and Translate
The Scan and Translate application allows you to scan
and translate text. You can install additional dictionaries
using the CD supplied with your Pen. See page 14.
Scan to PC
The Scan to PC application enables you to scan text
directly into Windows applications. See page 22.

Scanning Training
Learn how to scan using the built-in scanning training.
See page 25.

Send Stored Files to PC
Activates the process, which transfers files between your
Pen and PC. See page 26.
Options
Allows you to change settings on your Pen, such as the
scanning language and the menu type. Use advanced
options to initiate communication between your Pen and
PC. See page 29.
Information
Displays information about your Pen's current status. See
page 31.
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Scan and Store

Use Scan and Store to scan printed text, such as
excerpts from journals and books, into your Pen. Access
Scan and Store from the Pen Main Menu.

To create a new file, select Create New File from the
Scan and Store Menu which opens as soon as you
enter the application. Press ESC from the Scan and
Store Menu to return to the Pen Main Menu.
The scanning screen will appear, with a blinking cursor:

Scan text directly into this screen. The text appears
highlighted. If the scanned text is unclear, erase it by
pressing ENT while it is still highlighted. Otherwise,
continue scanning. The next scans will appear
consecutively on screen.
To erase individual characters, move the blinking cursor
to the point after the character you wish to erase and
press ENT.
To insert text at a specific point, move the blinking cursor
to that point using the direction keys. New scanned text
will be inserted at the location of the blinking cursor.
Scroll through the text using the direction keys. Insert a
new paragraph at the end of the text by pressing .

Use the Set New File Language option in the Scan and
Store Menu to change the scanning language for the
next new file you create.
12
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Transferring Files to the PC

To transfer stored files to the PC, launch the WizCom
Desktop, connect the USB cable to both Pen and PC and
select Send Stored Files to PC from the Pen Main
Menu. To change the default Send Stored Files to PC
settings, see Change File Transfer Settings on page 28.

The Scan and Store Menu

The Scan and Store Menu contains the following
options. Select the option to perform the function
described. To return to the Scan and Store Menu from
within a file, press ESC.

Edit Current File
The last file you opened is called the current file. Select
this option to open the current file for editing.
Create New File
Select this option to create a new file. Scan in the file
name and select OK. The scanning screen will appear.
Open File
Open an existing file for viewing or editing.
Delete File
Delete an existing file.

Set Scanning Direction
Choose between horizontal and vertical scanning when
the file language is set to Chinese.

Set New File Language
Choose the scanning language you wish to use for the
next new file you create.
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Beam Current File
Beam files using infrared communication. Files can be
transferred using IrOBEX compatible devices, such as
PDAs (Palm, IPAQ etc), or Smartphones.
a. Open the note you wish to send and return to the
Scan and Store Menu.
b. Confirm that the infrared port on the receiving device
is enabled to receive.
c. Align the infrared screens on both the sending and
receiving devices.
d. In the Scan and Store Menu scroll down to Beam
Current File and press ENT.
e. Wait for the success confirmation on the Pen.

Scan and Translate

Use the Scan and Translate application to scan and
translate text in various languages. Hear scanned text
read aloud from either the Split Screen or the
Dictionary Screen.

Access Scan and Translate from the Pen Main Menu.
You will reach the Input Screen and the red light at the
tip of the Pen will flash. Scan into any screen as long as
the red light is flashing. Scanning is disabled when
accessing menus.

The Scan and Translate Screens

The Scan and Translate application has three main
screens, the Input Screen, the Split Screen and the
Dictionary Screen. You can scan into any screen when
the red light at the Pen tip is blinking. Text on screen will
be over-written by the newly scanned text.
14
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The Input Screen

This is the screen that appears when you enter the Scan
and Translate application. Scan text directly into this
screen. The box on the top right shows the currently
selected dictionary.

 After scanning, text is displayed in the Split Screen
or the Dictionary Screen.

 Press ENT from the Input Screen to access the
Scan and Translate Menu.

The Split Screen

The Split Screen appears after scanning more than one
word. The scanned text appears on the top of the screen,
and the translation of the highlighted word appears on the
bottom of the screen.







Scroll through the scanned text using
or . The
arrow indicates that scrolling to the right will reveal
the rest of the scanned text.
Scroll through the dictionary entry for the highlighted
word using
or .
Press ENT to view the highlighted word in the
Dictionary Screen.
If the selected dictionary supports reading aloud, use
to scroll to the
icon (voice). Highlight the icon
to hear the scanned text read aloud. Press ENT to
hear the text read aloud again.
Press ESC to return to the Input Screen.
15
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The Dictionary Screen

The Dictionary Screen appears after scanning a single
word, or after selecting a word from the Split Screen.





Scroll through the dictionary entry using
or .
If the selected dictionary contains support for reading
aloud, press ENT to hear the word read aloud.
If accessed from the Split Screen, press ESC to
return to the Split Screen.

The Scan and Translate Menu
Press ENT from the Input Screen to access the Scan
and Translate Menu. To return to the Input Screen
press ESC.
The Scan and Translate Menu contains the following
options. Options may vary depending on the selected
dictionary:
Hear English Speech
When Hear English Speech is selected, the Scan and
Translate application reads scanned text aloud the
moment you select it for translation.
Set Volume
Use this option to adjust the volume level of the speaker.
1. Select Set Volume. The adjustment bar appears.
2. Adjust the volume level to the setting you want using
or
and press ENT.
Set Speaking Speed
This option enables you to adjust the speed at which the
Pen pronounces words.
1. Select Set Speaking Speed.
2. Adjust the speed using
or
and press ENT.
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Set Scanning Direction
This option allows you to choose between horizontal and
vertical scanning in dictionaries such as Chinese
SimplifiedEnglish.
View Translated Words
This option displays a chronological list of the most
recently displayed words, with the last word you defined at
the top. The history list can store up to 80 words. Once
the list is full, the oldest word is deleted from the list to
make room for the most recent one.
Select Dictionary
View a list of the dictionaries on the Pen and change the
selected dictionary. This option is only available if there is
more than one dictionary installed on the Pen.

The Dictionary Entries
The dictionary entries contain various elements and
indicators. The following examples are taken from the
English to Chinese Simplified and German to English
dictionaries.
Note: Not all dictionaries contain all the elements
mentioned.

Scroll Arrows
The scroll arrows on the bottom right of the screen
indicate that you can scroll up and down to view the entire
dictionary entry.
17
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Word List

The Word List sign appears at the top right of the
Dictionary Screen and indicates that there are
additional entries for the headword on screen. Press ESC
to view the Word List.
The Word List appears:
 When the scanned word corresponds to more than
one dictionary entry. For example, if you scan the
word “dressing”, the Scan and Translate application
enables you to choose between the dictionary
entries “dress” and “dressing”.
 When the scanned word is a homonym, a word that
is the same as another in spelling but different in
meaning.
 After scanning an idiom or phrasal verb, Scan and
Translate will automatically recognize the entire
phrase from the first word highlighted, and will
provide a Word List containing both the whole idiom
and the first highlighted word.

Headword

The selected word or a derivative of the selected word,
may consist of more than one word. The screenshots here
display the headword "special" and the word "ate", a
derivative of the headword "eat".
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Phonetics

The phonetic transcription of the headword.

Parts of Speech

Categories of words that describe their particular function,
e.g. nouns, verbs, adjectives.

Idioms

Expressions or phrases usually composed of a sequence
of words. They can be identified:
 Automatically within a sentence
 By scrolling through the translation of the first word
of the sequence.
If you scan text containing an idiom, Scan and Translate
will automatically display the translation of the idiom when
the first word is highlighted, i.e. the idiom "From A to Z"
displayed from the headword "From".
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Split Verbs

If you scan a single word which is part of a split verb:
1. The translation will appear along with the Word List
icon. In the Word List, the SPLIT VERB option
appears allowing you to scan the first part of the split
verb.
2. The message “Scan 1st part” will appear allowing you
to scan the first part of the split verb in order to view
the translation of the entire verb.
If you scan a line of text containing a split verb (e.g., in the
German to English dictionary), the Scan and Translate
automatically recognizes the verb and combines the parts.
The dictionary entry for the verb is displayed as soon as
you highlight the first part of the verb that appears in the
sentence. For example, if you scan in the sentence "ihr
stellt etwas auf", the dictionary entry for "aufstellen"
appears as soon as you highlight "stellt".

Compound Words

If you scan a word that is not a dictionary entry, but is a
compound word consisting of existing dictionary entries
(e.g., in the German to English dictionary), the Scan and
Translate separates the compound word into its
respective entries.
The translation of the primary word in the compound word
appears first, with the Word List sign next to it.
20
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To display the dictionary entry for another part of the
compound word:
 Press ENT to go to the Dictionary Screen (if you
scanned more than one word).
 Press ESC to display the word list.
 Scroll to the word you want to translate and press
ENT.
 For
example:
If
you
scan
the
word
‘Sprachgemeinschaft’, the entry for ‘gemeinschaft’
appears. Go to the word list and select ‘Sprache’ to
view its translation.

Hear Scanned Text Read Aloud

Scanned text can be read aloud from both the Split
Screen and the Dictionary Screen. Adjust the volume
using Set Volume in the Scan and Translate Menu.
Note: Not all dictionaries have text-to-speech functionality.
The Hear English Speech option can be accessed from
the Scan and Translate Menu when the source
language of the selected dictionary is English.
When Hear English Speech is selected:
 Scrolling through the text in the Split Screen will
cause the word to be read aloud as it is highlighted.
 Accessing the Dictionary Screen by either
scanning a single word or from the Split Screen will
cause the word to be read aloud automatically.
When Hear English Speech is not selected:
 Scrolling to the left in the Split Screen until the
icon is highlighted will cause the entire sentence to
be read aloud. Press ENT when the icon is
highlighted to hear the text read aloud again.
 Press ENT to hear the word read aloud in the
Dictionary Screen.
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Homograph Pronunciation
A homograph is one of two or more words that have the
same spelling but differ in origin, meaning, and sometimes
pronunciation, such as "fair" (pleasing in appearance) and
"fair" (market) or "wind" (wĭnd) and "wind" (wînd).
If the selected word is a homonym, Scan and Translate
will read out all the options for pronouncing the word.

Scan to PC

Use Scan to PC to scan text and send it directly to the
PC. Text can be scanned into any file or application on
the PC that has a blinking cursor. Access the Scan to PC
application by selecting it from the Pen Main Menu.

Scan to PC works in the same way as standard editing
using a keyboard i.e., highlighted text is overwritten, text
is inserted in Insert Mode or overwritten in Overwrite
Mode. Using Scan to PC does not interfere with your
regular use of the Windows application.
To use Scan to PC, the WizCom Desktop must be
running on the PC. If there is no Scan to PC compatible
application open on screen, the text will still be sent from
the Pen, but will not be accessible on the PC. The
WizCom Desktop does not need to be maximized on
screen as long as it is running (the
icon appears in the
notification area of the Windows taskbar).
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Using Scan to PC

To use Scan to PC:
1. Launch the WizCom Desktop.
2. Make sure that the Pen is connected to the PC with
the USB cable.
3. Ensure that communications are working between
your Pen and computer. If you are not sure if your
communications
are
working,
run
the
Communications Wizard from the Help menu on
the WizCom Desktop Menu Bar.
Note: If you have problems with Pen-PC
Communications,
see
Establishing
Pen-PC
Communications on page 9.
4. On your Pen, select Scan to PC from the Pen Main
Menu. The application opens in the scanning screen
so you can start scanning immediately.
5. When you have finished scanning, press ESC on the
Pen to exit Scan to PC.
Note: Scan to PC works in most Windows applications;
however, it may be incompatible with some applications.

Scan to PC Settings in the WizCom
Desktop

Use the Scan to PC Settings in the WizCom Desktop
to determine what key is inserted after each line of text is
sent to the PC application. The default setting is Space,
meaning that a space is inserted after each scan appears
in the application.
Access Scan to PC Settings from the Pen
Communications menu on the WizCom Desktop
Menu Bar.
From the Scan to PC Settings menu define the key you
want to enter after each scan:
 Space: Inserts a space after each scan.
 Tab: Inserts a tab after each scan.
 New Line: The cursor moves to the next line after
each scan.
23
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 Nothing: Nothing is inserted after each scan; the

next scanned text will be inserted immediately after
the last character of the previous scan.

Scanning in Different Languages
On the Pen:
Use the left/right direction keys to change the scanning
language. When the scanning language is set to Chinese,
use the up/down direction keys to switch between
horizontal and vertical scanning.
On the PC:
If you are scanning in languages other than English, your
Windows settings (non-unicode programs option) must be
configured to fully support the language you wish to use. If
the version of Windows you are using does not support
the character set of the language you have selected, you
will not be able to view the character set correctly.
Language settings can be accessed through the
Windows Control Panel settings (name of application
varies depending on which operating system you are
running).
The keyboard corresponding to the scanning language
you require should be installed and should be active in the
Windows application you wish to scan into. The WizCom
Desktop language bar should be set to the required
language.
To confirm that the language settings are correct in the
Windows application, open the application you wish to
scan text into and attempt to type text in the required
language. If it appears correctly, the Windows application
is ready.
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Scanning Training

Use the scanning training to learn how to scan correctly
with your Pen.
Follow the instruction on the Pen. Use the left/right
direction keys to move between screens and the ESC key
to exit.
The scanning language correlates to the interface
language currently selected on the Pen.
The training provides you with two options
1.

Scanning with the training card and plastic scanning
Trainer provided with the Pen.
The following is the text provided on the training card:
Chinese Simplified:

English:

Use this training as many times as you want to
perfect your scanning technique.
2.

Scanning without the training card.
Use this scanning training to practice scanning
freehand without the plastic scanning Trainer.
25
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Send Stored Files to PC

Use the Send Stored Files to PC option in the Pen
Main Menu to transfer Scan and Store files from your
Pen to the PC using the Desktop application
To use Send Stored Files to PC, the WizCom Desktop
must be running on the PC. The WizCom Desktop does
not need to be maximized on screen as long as it is
running (the
icon appears in the notification area of the
Windows taskbar).
Before using Send Stored Files to PC, make sure to
modify the default settings in the WizCom Desktop by
accessing the File Transfer Settings option from the
Pen Communications menu in the Menu Bar.
To transfer files using Send Stored Files to PC do the
following:
1.
2.

3.
4.
5.

26

Connect the USB cable to both the Pen and the
PC.
Make sure that Pen communications are set to On
in the Desktop and that communications have
been established (see Establishing Pen-PC
Communications on page 9).
On your Pen, scroll down to Send Stored Files
to PC in the Pen Main Menu and press ENT.
A dialog box will open on the PC showing the file
transfer process.
The success message will appear when the Send
Stored Files to PC process has completed.
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File Transfer Settings in the Desktop

Use the File Transfer Settings dialog box to determine
what happens to files saved on the Pen when you select
Send Stored Files to PC from the Pen Main Menu.
If you have several Pens using the same Desktop
application, you can define individual settings for each
Pen, based on their individual Pen names.

To define File Transfer Settings:
1.

2.

3.

4.
5.

Select File Transfer Settings from the Pen
Communications menu on the Menu Bar of the
Desktop to reveal the File Transfer Settings menu.
Make sure that the Pen name shown is the same as
the Pen you are using. If not, select the correct Pen
name from the drop-down list.
To select the file transfer function for each application,
either double-click on the application name in the
table, or click on the application name and then click
the Change button. The Change File Transfer
Settings menu will appear. It displays the options
available for the Scan and Store application. See
below for more information.
Select the option you wish to use and click OK.
If you want the File Transfer Settings dialog box to
appear before each Send Stored Files to PC
27
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6.

operation (to verify the settings), click on the Show
this Dialog before each file transfer checkbox
prior to closing the dialog box.
When you have finished, close the File Transfer
Settings menu by clicking on the Close button.

Change File Transfer Settings
There are two options available when transferring Scan
and Store files to the PC:
1. Pen to PC: The Pen files are copied from the Pen
to the computer, overwriting the corresponding files
on the computer. To erase files from the Pen after
synchronizing check the Flush option.
2. Don’t transfer the files of this application: No
files are transferred between the Pen and computer;
the files remain untouched.

Synchronize with Host Applications
If you want your files to be saved in Microsoft Office
compatible formats you must activate the Host Settings
function in the File Transfer Settings menu.
1. Select File Transfer Settings from the Pen
Communications menu on the Menu Bar of the
Desktop. The File Transfer Settings menu
appears.
2. Check the option This Pen Name will transfer
files with host applications.
Note: Only one Pen can be associated with host
applications. If the checkbox is disabled it means
another Pen has already been selected to interact
with these applications. If you wish to change it, go
through the Pen names list, find the one where the
option is checked and deselect it.
3. Click on the Host Settings button (now enabled).
4. Look at the information for Scan and Store in the
Host Application column. Click on the column and
a drop-down menu will appear.
5. Select the option you wish to activate.
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The Options Menu

Modify the default Pen settings using this menu which can
be accessed via the Pen Main Menu. To select an option,
scroll to the required option using
or
and press ENT
when the option is highlighted. To return to the previous
screen without making changes, press ESC.
The Options menu contains the following:

Set Interface Language
Use this option to change the language in which menus
and messages appear. Select Interface Language.
Scroll to the interface language you want, using
or
and press ENT.

Set Right/Left Handed
Use this option to switch between right and left handed
modes. Switching between these modes rotates the text
on the display 180°.
1. Select Set Right/Left Handed.
2. Scroll to the mode you prefer using
or
and
press ENT.

Set Black/White Text
Use this option to switch between scanning white text on
a dark background and scanning dark text on a light
background.
1. Select Set Black/White Text.
2. Scroll to the mode you prefer using
or
and
press ENT.
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Set Auto Shut-Off Time
If the Pen is not in use it will shut down automatically after
two minutes. Use this option to change the automatic
shut-off time.
1. Select Auto Shut-Off Time.
2. Choose the auto shut-off time you want using
or
and press ENT.
Set Contrast
Use this option to adjust the brightness of the display.
1. Select Set Contrast; the adjustment bar appears.
2. Adjust the contrast using
or
and press ENT.
The higher the number, the darker the display.

Advanced Options
Access this option to initiate Pen-PC Communications, to
change communication settings and to compact Pen
memory.
Enter Upgrade Mode
Use Enter Upgrade Mode only when directed to by
®
the WizCom Desktop or the Quicktionary 2 Premium
CD. It is accessed from Options\Advanced Options
in the Pen Main Menu.
Enter Upgrade Mode is used by the Desktop to
optimize the Pen file system, to check Pen-PC
Communications using the Communications Wizard
and to launch the Add\Remove Pen Components
®
dialog. It is used by the Quicktionary 2 Premium CD to
install dictionaries.

See Establishing Pen-PC Communications on page
9 to ensure that your Pen and PC are set up correctly
for communication.
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Set Serial/IR Comm.
Use this option to select the connection device being
used for Pen-PC Communications (USB cable or
infrared). It is recommended that the USB cable is
used when communicating with the computer.
1. Select Set Serial/IR Comm..
2. Scroll to the required device using
or
and
press ENT.
Set Baud Rate
The baud rate should always be set to 115,200.
1. Select Set Baud Rate.
2. If the baud rate is not 115,200, scroll down using
until it is visible on screen and press ENT.
Compact Memory
Maximize free space on the Pen's extension card by
compacting components already on the Pen.

The Information Menu

The Information menu displays the following Pen
information:
View Battery Status
Check how much power is left in the batteries. A diagram
displays the power level.
View Memory Status
See how much memory is left on the Pen's extension card.
This option is useful if you wish to know if your Pen
contains enough free memory to install extra components
such as dictionaries.
View Serial Number
View the Pen’s serial number.
Versions and Copyrights
View Pen version number, copyright information and
version number of the Pen operating system.
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The WizCom Desktop
The WizCom Desktop is the application your Pen uses
to communicate with and transfer data to your PC. It has
two main functions:
1. Transferring stored data from the Pen to the PC using
the Send Stored Files to PC option on the Pen.
2. Scanning data directly into Windows applications
using Scan to PC.
You can also use the Desktop to view and edit the text
sent from the Pen to the PC, convert sent files to other
formats, modify Pen components and optimize Pen
performance by compacting the Pen file system.

Running the Desktop
If, during installation, you selected the option for the
Desktop to run upon Window's start-up, the Desktop will
automatically start running when you start your computer.
To open the Desktop window, click the Desktop icon
in
the notification area of the Windows taskbar and select
the Show Window option from the pop-up menu.
If the Desktop application does not run when you start up
your computer, or if you closed the application, you can
start it by opening the Windows Start menu and selecting
Programs\WizCom Desktop\WizCom Desktop.

Exiting the Desktop

To exit the Desktop, select Exit from the File menu. Or
click the Desktop icon, then select Exit.
Pressing ALT+F4 on the keyboard or clicking
in the
upper-right corner of the Desktop window closes the
Desktop window, but does not close the Desktop
application. The application continues to run in the
background, and the Desktop icon remains in the
notification area of the Windows taskbar.
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The Desktop User Interface
The Desktop is divided into three main sections:

1. Menu Bar: The Menu Bar runs across the top of the
screen. It contains all the options for using the
Desktop.
2. Toolbar: The Toolbar is an iconic interface
containing some of the main Desktop features.
3. Desktop Window: The Desktop Window is where
all the files transferred between the Pen and PC can
be viewed and edited.

The Menu Bar

The Menu Bar runs across the top of the screen. It
contains four menus.
The Menu Bar

To select an option, click on the menu and then click on
the option in the drop-down list. Some menus can be
activated using shortcut-key commands which are shown
on the right of the menu option. Press the key sequence
shown to execute the shortcut-key command.

The File Menu

The File Menu contains the following options:
 New: Create a new file.
 Open: Open an existing file.
 Save As: Save an existing file in a different location/
format.
 Pen Names: Add, rename or delete Pen Names.
 Find: Search for words in the current file.
 Print: Print the current file.
 Exit: Exit the Desktop. Note: Selecting
will
minimize the application to the Windows Taskbar.
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The Pen Communications Menu

The Pen Communications Menu contains the following
options:
 Turn Pen Communications Off/On: Toggle
communications on and off.
 Add/Remove Pen Components: For advanced
users only! Should not be accessed unless advised
by Support.
 Optimize Pen File System: Clear empty spaces on
your Pen extension card caused by file transfer and
deletion.
 Communications Settings: Define communication
settings for Pen-PC communications.
 File Transfer Settings: Define the settings for PenPC file transfer.
 Scan to PC Settings: Choose the key you wish to
insert after each line of text is sent to the PC. The
default setting is Space.

The View Menu

The View Menu contains the following options:
 Log: View the history of the last three File Transfer
sessions.
 Interface Language: Change the language in
which menus and messages appear in the Desktop.
 Text Size: Change the text size in the Files and
Current Files Panes.
 Toolbar: Hide or show the Toolbar, which contains
icons for accessing some of the main Desktop
functions.
 Status Bar: Hide or show the Status Bar at the
bottom of the screen which provides information
about the current status of the application files you
are viewing in the Desktop application.
 Applications: The applications shown in the View
menu vary depending on the applications installed on
your Pen. Select an application to view the
application files in the Desktop Window.
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The Help Menu

The Help Menu contains the following options:
 Help: Access the Desktop online help document.
 Communications
Wizard:
Run
the
Communications
Wizard
to
establish
communications between your Pen and the PC.
 Register at WizCom Site: Register your Pen on the
WizCom website.
 About: View the Desktop copyright and version
information.

The Toolbar

The Desktop Toolbar is located beneath the Menu Bar
and allows quick access to some of the most-used
Desktop functions. To select a toolbar option, click on the
icon. To hide or show the toolbar, select Toolbar from the
View menu.

The Toolbar contains the following options:
New: Create a new file in the selected
application.
Open: Open a file in the selected application.

Save As: Save the current file under a new
name or in a different format.
Print: Print the current file.
Pen Names: Add, rename or remove Pen
Names.
Add/Remove Pen Components: Add or
remove Pen components.
Turn Pen Communications Off/On: Toggle
Pen communications off and on.
Current Pen Name: Shows
the name of the Pen currently
selected on the Desktop.
Help: Accesses the Desktop online help.
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Desktop Window
The Desktop Window is split into vertical panes. To resize
or hide a pane, drag the split bar between two panes to
one side.

Applications Pane

The left pane is the Applications Pane and displays the
icons of all the applications installed on the Pen. Click on
the application icon to view the files associated with the
application.

Files Pane

The Files Pane displays the list of files for the application.
Select a file name to view the contents of the selected file
in the right pane, the Current File Pane.

Current File Pane
Files can be created, opened and edited in this section.
To open a file, select
from the toolbar or Open from
the File menu and choose the file you wish to open. For
applications with a middle pane, click on a file from the
Files Pane. Only one file can be opened at a time.
Note: Any changes made to files are saved automatically.
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The WizCom Desktop Taskbar Icon
The Desktop icon
is located in the notification area of
the Windows taskbar. If you have set the Desktop to
launch upon startup, the icon will appear automatically
each time you start your computer. If not, the icon will
appear only after you launch the Desktop.
When the Desktop is open on screen, clicking the
icon
on the top right of the screen will not exit the application,
but will cause it to minimize to the taskbar.
The Desktop is still running in this state. Clicking on the
icon will cause a pop-up menu to appear with the
following options:

The Taskbar Menu contains the following options:

 Hide/Show Window: Minimize or maximize the
Desktop application.

 Turn Pen Communications On/Off: Activate or
deactivate Pen-PC Communications.

 File Transfer Settings: Modify the file transfer

settings using the File Transfer Settings dialog
box.
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 Scan to PC Settings: Define the character to be





inserted after each line of text you scan using the
Scan to PC Settings dialog box.
Log: See the log of the last Pen-PC communication
activity.
Help: Access this document.
About: View the copyright and version information
for the Desktop application.
Exit: Exit the Desktop application.

Changing
Language

the

Desktop

Interface

The Desktop contains support for both Chinese Simplified
and English user interfaces.
To change the Desktop interface language:
1. Select Interface Language from the View menu on
the Menu Bar. The Interface Language dialog box
appears.
2. Select the interface language you want from the list
and click OK.
3. Restart the Desktop.
Note: Your Windows settings (non-unicode programs
option) must be configured to support the selected
language. If your Windows version doesn’t support the
character set of the selected language, you will not be
able to view the character set correctly.
Language settings can be accessed through the Windows
Control Panel Regional and Language Options
setting (name of setting menu varies depending on which
operating system you are running).
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Pen-PC Communication Settings
There are four ways in which the Pen communicates with
the PC via the Desktop application:
 Send Stored Files to PC (initiated by Pen)
 Scan to PC (initiated by Pen)
 Optimize Pen File System (initiated by Desktop)
 Launching the Add\Remove Pen Components
dialog (initiated by the Desktop)
When communicating with the PC, the Pen must be
connected to the PC using the cable provided with the
Pen.

Communication Settings

The Communications Settings dialog box (accessed
from the Pen-PC Communications menu on the Menu
Bar) allows the following information to be modified:
 The type of communications (either Cable or InfraRed).
 The communications port on the computer to which
the connection device is associated.
 The communications baud rate (the speed at which
the data is transmitted), if you are using a cable.
 The Infra-Red driver, if you are using Infra-Red
communications.
Communications settings must be defined correctly on
both the Pen and Desktop in order for the two to
communicate.
See
Establishing
Pen-PC
Communications on page 9 to configure the correct
communication settings for both the Pen and PC.

Desktop
Modes
Turn
Communications Off/On

Pen

The Desktop application runs in two modes - online or
offline. The default mode is online.
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Offline Mode
When the computer is offline, communications with the
Pen are disabled. The Desktop cannot detect
communications from, or initiate communications with the
Pen. The Pen Communications menu options are
disabled.
To disable Pen communications, select Turn Pen
Communications Off from the Pen Communications
menu on the Menu Bar, or deselect the
icon on the
Toolbar.
The
option
toggles
to
Turn
Pen
Communications On.
Select Turn Pen Communications On to re-enable Pen
communications.
Online Mode
When you are working online, communications with the
Pen are enabled. The Desktop occupies the
communications port on your computer and is in a state of
readiness to receive communications from the Pen. It
detects Send Stored Files to PC or Scan to PC
commands being sent from the Pen, and can also initiate
Desktop-controlled communications, such as optimizing
the Pen file system using the Pen's PC-Controlled
Communication option.
Note: When Pen communications are enabled, the
communications port specified in the communications
settings on the Desktop is busy, and cannot be used for
any other purpose.

Optimize the Pen File System
When you delete data from your Pen (either manually or
by using the Flush option in the File Transfer Settings
dialog box), the area that was used by the data is not
actually deleted from the extension card memory. The
Optimize Pen File System option enables you to free
up those areas on the Pen’s extension card memory that
are no longer being used by application data.
To optimize your Pen's file system:
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1. Turn your Pen on and select Options/Advanced
Settings/ Enter Upgrade Mode.
2. Select Optimize Pen File System from the Pen
Communications menu on the Menu Bar of the
Desktop application. A progress bar appears on the
computer that displays the progress of the
optimization process.
 If communications between your Pen and PC fail,
an error message appears when you select
Optimize Pen File System. Try running the
Communications Wizard from the Help Menu
on the Menu Bar to correct the communications
setup.
 If the Pen you have connected is not recognized
by the Desktop, you are prompted to use the
current Pen Name, choose an existing Pen
Name or create a new Pen Name.
3. When the process is complete, a success message
will appear.
Important: Do NOT abort the Optimize Pen File
System process before it is completed. Failure to
complete the process may result in the loss of all the Pen
data.

Add/Remove Pen Components

The Add/Remove Pen Components menu is
accessible via either the Pen Communications menu on
the Menu Bar of the Desktop application, or by clicking
in the Toolbar. The dialog can only be launched when
the Pen is connected to the PC and Enter Upgrade
Mode has been selected on the Pen.
This dialog is for advanced users only and should not be
accessed unless directed to by Support personnel.
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Recover Components Deleted from
the Pen

If you do access the Add/Remove Pen Components
menu and accidentally delete components from the Pen,
use the Pen CD to reinstall the lost components.
The CD contains a Restore Pen option which will restore
any components you may have deleted.

Managing Several Pens in the Desktop
You can use more than one Pen with the same Desktop
application. Each Pen is defined on the Desktop by a
unique Pen Name to make it recognizable by the
software. The Pen Names dialog box contains several
options for managing the Pens in the Desktop. Use it to
add, rename or remove a Pen or to set the current Pen.
Access the Pen Names dialog from the File menu on the
Menu Bar or by clicking
on the Toolbar. The default
Pen Name is "MyPen".

Adding, changing and deleting Pens





To add a Pen: Open the Pen Names menu and
select Add. Type in a name for Pen and click OK.
To change a Pen: Open the Pen Names menu and
select the Pen Name you want to change. Select
Rename, type the new name into the Rename box
and click OK.
To delete a Pen: Open the Pen Names menu and
select the Pen Name you want to delete. Select
Remove, click Yes when the confirmation message
appears and click OK.

Set the Current Pen
You can change the current Pen at any time by using the
Current Pen drop-down list in the Toolbar.
Alternately, to set the current Pen: Open the Pen Names
menu and select the Pen Name that you want to set as
the current Pen. Select Set as Current and click OK.
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Working with Files in the Desktop
To create new files: Click on the Scan and Store icon
and click on the Toolbar. Type a name in the New
File box and click OK.
Add or delete paragraphs by right-clicking in the Current
File Pane and selecting the required option from the
menu.
To edit files: Select the file you want to edit from the
Files Pane. Double-click on the paragraph you wish to
edit and a blinking cursor will appear at the beginning of
the paragraph indicating that the text in the paragraph can
be edited using the regular Windows keyboard editing
commands.
Note: All modifications made to files are automatically
saved by the Desktop.
To open an existing file or import a file: Clicking on the
application icon in the Application Pane and click
on
the Toolbar. Locate the file you wish to open and click
Open.
To save files with a different name or in a different
format: Click
on the Toolbar. Choose the format, file
name and location and click Save.
To delete files: Right-click on the file you wish to delete
in the Files Pane and select Delete File from the pop-up
menu.
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Additional Information
Batteries
Your Pen comes with 2 AAA Alkaline batteries. If the
batteries are low, the "Replace Batteries" message
appears on the Pen. When the batteries are about to run
out, the Pen shuts down automatically. Many issues may
occur on the Pen due to low batteries. If you encounter
strange behavior, check the battery level in the
Information menu and replace batteries if relevant.

Safety Points (Batteries)
CAUTION: Risk of explosion if battery is replaced by an
incorrect type. Use AAA Alkaline batteries only.
 Always place 2 fresh batteries in the Pen. It is not
advisable to use the Pen with batteries that are not
at the same voltage level.
 Do not combine different types of batteries (e.g.
rechargeable and non-rechargeable).
 Dispose of used batteries according to the
manufacturer's instructions.

Pen Maintenance
Your Pen conforms to the highest standards of
craftsmanship and manufacture. To keep your product in
good condition, follow these guidelines:
 Store in protective case when not in use.
 Keep away from excessive moisture and
temperature extremes.
 Clean using a soft, damp cloth.
 Avoid exposing to direct sunlight for extended
periods of time.
CAUTION: To reduce the risk of electrical shock or
damage to the internal components, do not spray liquid
directly on the screen or allow excess liquid to drip inside
your Pen.
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Product Specification
Feature
Display Information
Keypad

Description
Resolution: 122 x 32 pixels
Size: 61mm x 20mm / 2.4” x .8”
Push
Buttons
Power/ESC/ENT/Up/Down/Left/Righ
t)
ARM 7 TDMI

CPU
Memory
192KB
 RAM
8 MB
 ROM
 External memory 4MB, 6MB or 8MB
card
Communications
USB Cable, Infrared IrOBEX
Optical Scanner
 128 pixels linear array image
sensor
 400 DPI resolution
Power
2 x 1.5V AAA Alkaline batteries
Size
L x W x H:
163 mm x 38 mm x 23 mm
(6.4” x 1.5” x 1”)
Weight
90 grams (3 oz.) without batteries +/flash memory card)
Safety
 CE
 RoHS
 UL
 FCC class B
Operating Temperature 0°C - 40°C
Range
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Copyrights and Trademarks

© 2008 WizCom Technologies Ltd. All rights reserved.
WizCom Technologies Ltd. uses the Ligature OCR-on-aChip copyright
© 1995-2008, Ligature Compression Technology
copyright © 1996-2008, and Ligature reverse inflection
and derivation technology copyright © 1997-2008 under
license from Ligature Ltd. All rights reserved.
WizCom InfoScan, QuickLink-Pen, Quicktionary,
Readingpen, WizCom SuperPen, WizCom and Pen
design are trademarks or registered trademarks of
WizCom Technologies Ltd. All rights reserved.
All other brands and product names appearing here are
registered trademarks or trademarks of their respective
owners.

Worldwide Limited Warranty
WizCom Technologies Ltd. (hereinafter - "WizCom") warrants
the initial purchaser (hereinafter - "PURCHASER") of each of
the products bearing the trade names or trademarks
Quicktionary, ReadingPen, SuperPen, InfoScan, QuickLink or
MEK (hereinafter - "PRODUCT") sold by WizCom (including
sale through WizCom's Web Site) or WizCom's authorized
local retail dealer (hereinafter - "AUTHORIZED RETAILER")
as follows:
WizCom warrants that your PRODUCT, under normal use,
will be free of defects in materials and workmanship for a
period of two (2) years from the date of original purchase
from WizCom or from WizCom's AUTHORIZED RETAILER.
This limited warranty extends only to the original Purchaser of
the PRODUCT and is not assignable or transferable to any
subsequent purchaser/end-user.
WizCom's sole obligation, and Purchaser exclusive remedy,
under this express warranty, in lieu of all other warranties
express or implied by law or otherwise, shall be, at WizCom's
option and expense, to repair or replace- either with new
parts or used parts, without charge, PRODUCTS that are
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found to be defective and malfunctioning during normal
usage and returned within the warranty period, provided that:
(i) The PRODUCT has not been damaged or subjected to
mishandling, improper storage, misuse, neglect, abuse,
accident, alteration, abnormal operation or conditions,
operation in an unsuitable environment or in a manner for
which it is not intended, unauthorized repair, unauthorized
modifications, or other acts which are not the fault of WizCom.
(ii) The PRODUCT has not been damaged from external
causes such as fire, flooding, sand, dirt, storm or any other
damage from weather conditions, an Act of God, theft, or
battery leakage, blown fuse, or improper use of any electrical
source, damage caused by computer or internet viruses,
bugs, worms, Trojan Horses, cancelbots or damage caused
by the connection to other products not recommended for
interconnection by WizCom.
(iii) No one other than an authorized WizCom representative
opens the casing of the PRODUCT.
(iv) WizCom has been advised in writing by the PURCHASER
of the alleged defect or malfunction of the Product within
fourteen (14) days after the expiration of the applicable
limited warranty period.
(v) This limited warranty does not cover physical damage to
the surface of the product, including breakage, cracks or
scratches on the LCD screen or outside casing.
(vi) The liability under this warranty is limited to the actual
cash value of the PRODUCT, determined by the price paid by
the Consumer for the Product less a reasonable amount for
usage.
Repair or replacement of the PRODUCT shall not extend the
original warranty period.
PURCHASER will be charged for all PRODUCT repairs for
damage or failure not covered by this limited warranty.
Return of the PRODUCT for repair or replacement under this
warranty, must be made to PURCHASER'S local dealer and
must be accompanied by proof of date of purchase,
identification of the PRODUCT by model number and serial
number and complete description of the problem.
WizCom makes no warranty or representation that the
PRODUCT will meet the PURCHASER'S requirements or will
work in combination with any hardware or software products
provided by third parties, that the operation of the PRODUCT
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will be uninterrupted or error free, or that all defects in the
PRODUCT will be corrected.
EXCEPT AS EXPRESSLY SET FORTH IN THIS
WARRANTY, WIZCOM MAKES NO OTHER WARRANTIES
EXPRESSED OR IMPLIED, AND TO THE FULLEST
EXTENT PERMITTED BY LAW, WIZCOM DISCLAIMS ALL
OTHER WARRANTIES EXPRESSED OR IMPLIED,
INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR
A PARTICULAR PURPOSE OR USE.
In no event shall WizCom, its agents, officers or employees
be liable for any damages whatsoever, including (without
limitation) special, direct or indirect, punitive, consequential or
incidental damages, including, without limitation, damages
resulting from use of or reliance on the products and/or
services and/or advertisements regarding the PRODUCT,
loss of revenues, loss of profit, business interruption, loss of
information or costs of replacement goods, loss of use of the
product or any associated equipment, cost of capital, loss of
enjoyment of the PRODUCT, arising from claims of third
parties, including customers or arising from breach of the
warranty, breach of contract , negligence, strict tort, or any
other legal or equitable theory without limitation.
WizCom reserves its right to make technical alterations to the
PRODUCT and such alterations shall not be considered as
breach of warranty.
WizCom shall not be liable for any delays or defaults
hereunder by reason of fire, floods, acts of God, labor
troubles, accidents to machinery, delays of carriers or
suppliers, inability of suppliers to supply, the impositions of
priorities, restrictions or other acts of government, or other
causes beyond its reasonable control.
The agents, dealers and employees of WizCom are not
authorized to make modifications to the warranty, or
additional warranties that are binding on WizCom.
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[_] Sign up for updates

Additional information: _______________________________

What is your primary language? ________________________

What product did you purchase?________________________________________
Where did you purchase the product? [_] Computer Store [_] Office supply Store [_] Superstore [_] Duty Free
[_] Direct Mail [_] Magazine Advertisement [_] Received as gift [_] Bundled
[_] Other _______________________
How did you hear about this product? [_] Advertisement [_] Dealer [_] Exhibition [_] Magazine [_] Friend
[_] Other (Specify): _______________________
Why did you choose this product?
______________________
Where do you plan to use this product? [_] Home [_] Work

Serial Number: ______________________
Note: The serial number can be found by turning the Pen on and selecting the Information icon in the Pen Main Menu.

Phone: __________________ Fax: ______________ Email: ______________________________________

City: __________________ State: ________________ Zip/Postal Code: _______ Country: ______________

Address: _________________________________________________________________________________

First Name: __________________________________ Last Name:__________________________________

Complete and sent to: WizCom Technologies Inc., 234 Littleton Road, Ste. 1B, Westford, MA 01886, USA
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